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Using Microsoft Access 
 

Microsoft Access is a computer application used to create and work with databases. In computer 
jargon that means it’s a Database Management System or DBMS. 
So what is a database? A database is basically a collection of data or pieces of information. Whether 
you know it or not, you use databases all of the time. Some examples of commonly used databases 
might be: 
 

• Address book 
• Library catalogue 
• Telephone directory 
• Stock list 

 
A database isn’t necessarily contained on a computer. A telephone directory is still 
a database even if it’s in the form of a huge book sitting next to your phone. 
However, for the purpose of these exercises, we will assume that the term 
database refers to an organised collection of information stored on a 
computer. 
Databases are intended for storing and maintaining large amounts of 
information. The following are examples of the sort of information that can be kept 
in a database: 
 

• Inventory control 
• Payroll systems 
• Personnel records 
• Music collection catalogue 
• Phone and address lists 

 
In the exercises that will follow you will create a simple database while you learn the basic features 
of Access. Later on, you will create a more complex database as you learn more advanced features in 
addition to some of the principles of database theory. In these exercises it is assumed that you are 
familiar with Windows use and have experience in using other applications such as Word or Excel. 
 
Note Most of what is taught in these exercises will work fine in most versions of Access up to Access 2003. 

However, some features may be missing or slightly different in older versions. Also, databases 
created in newer versions of Access won’t work in some older versions. Screen shots in these 
exercises are from version 2003 though there is little difference in the 2002 (XP) version. 
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Getting to Know the Program 

Exercise 1. Starting Microsoft Access 
Like most applications, Access can be 
started in several ways, such as clicking 
the Microsoft Access shortcut in the 
Windows Start Menu as shown. The 
location on the start menu will vary on 
different computers. 
 

1) Start Microsoft Access by 
clicking its icon on the start 
menu (or by any other 
method you prefer). 

 
 
When Microsoft Access begins, you will 
see a window similar to the one shown 
below. 
 

 
 
On the top of the window you will see menus and toolbars similar to the ones found in most 
applications. On the right, you will usually see the task pane which provides shortcuts to common 
tasks, such as opening or creating a database (the task pane is also a feature of recent versions of 
Word, Excel and other Microsoft Office applications). 
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Creating a new Database 
You will notice that the first time you open Access the screen is rather empty and unfriendly. This is 
very different from other programs such as Word or Excel where you are presented with a new, 
ready to use document each time you start the program. This is because you can’t begin using a 
database without setting one up first, which takes a fair amount of effort. That is why you don’t get a 
blank, ready to use database when you begin the program. The first thing we will need to do is create 
a database to use. 
The first step is to create and save a blank database file. In other programs, you usually don’t save a 
file until you’ve done something with it but in Access, saving the file is the first step. This is because 
in Access, many things are automatically saved as you work so Access needs to know where to save 
it all right at the start. 

Exercise 2. Creating a Database File 
1) Make sure your task pane is showing. If it isn’t, go to the View menu and select Task Pane 

(or press [Ctrl][F1]). 
2) From the list of options in the task pane, click (you can also click the  

icon on the toolbar). 
3) From the new list of options which appears, click . 

 

 
 

4) For the file location, select (or create) and appropriate folder in your student drive. Type 
Student List for the file name and click Create. 

 
The file will be saved with a .mdb extension (for Microsoft Database). 
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Note Creating a database should normally only be done after a lot of planning has taken place. In the 
following exercises it is assumed that the database you will create has already been well planned. 
Later on we will get in to some procedures for planning a database. 
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The Database Window 
When you create a new database or an existing database, you will usually see the Database Window 
similar to the one shown below (any time it is hidden or covered by other windows you can press F11 
to make it appear). 
 

 
 
Databases are made up of various objects such as tables, queries and forms. The options down the left 
side will take you to the main sections of the database. The options at the top of the database window 
allow you open existing database objects , modify database objects  or create new 
database objects . 
Some older database management systems required you to create a separate file for each object in the 
database. In Access, all of these database objects are contained in the same database file. The first 
database object we will look at is tables. 
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Tables 
Tables are the most important component of an Access database because tables are where all of your 
information is stored. Tables in an access database are similar in many ways to Excel tables. Most 
Access databases will consist of more than one related table, but the first database we will create will 
be a simple, single-table database. Each table is made up of columns referred to as Fields and rows 
referred to as records. 
Example: A telephone book is made up of several related tables. There is the main table which 
contains all of the phone listings. There are also related tables containing information such as area 
codes and post codes. The following is an example of how a telephone listing may appear in a phone 
book. 
 
 

    Field   
       
 Name Initials Address Suburb Phone  
 Smith A J 12 Smith St Kalgoorlie 90911234  
Record Smith A L 18 Invisible Ave Kalgoorlie 90914321  
 Smith A R 4 My Street Boulder 90910987  
 Smith B D 912 Long Rd Kalgoorlie 90917890  

 
Each category of data (Name, Initials, Address etc) is a field. 
Each individual item of information (such as the information for A L Smith) is a record. 
 

Fields and Primary Keys 
When you create a new table, one of your first tasks is to create the fields that will make up the table. 
One of the fields should be a primary key. A Primary key is a field which is unique to 
each record. In the example above, Name is not unique for each record, since more 
than one record can contain the same name as shown. The same is true for Initials 
and Suburb. It is even possible that there may be more than one phone listing for 
people at the same Address. Therefore the only field which would be unique to 
each record is Phone, since each phone number would only have one listing in the 
table. This would make Phone a good choice for a primary key. The importance of 
primary keys will be explained more later on. 
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Exercise 3. Creating a Table 
1) Begin by making sure you are still in the Tables section of the database window.  

 
2) Click the  button to create a new table. 

 

 
 

3) The New Table dialog will appear. Select Design View from the list of options and click 
OK. A new blank table will now appear in the design view (You can also click the 

 option in the database window to create a new table). 
 
The table design window will look similar to the one below. 
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The top section of the window is where you enter the names of the fields in your table along with the 
data type for each field. When you have a field name selected in the top section, the bottom section 
will display properties which allow you to customise the selected field. 
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Field Data Types 
Each field in a table can be one of several available field types. When you enter a field name in the 
design view, the next column will allow you to choose a field type. The following field types are 
available to choose from. You will use several of these in later exercises. 
 
Text This is the default field type since it is the most commonly used. Text fields can 

store any kind of text/numeric characters with a maximum of 255 characters. 
This field is best suited for text or numbers that don’t require calculations (such 
as phone numbers) 

Memo Stores large amounts of text or numbers – up to 65,535 characters. Uses more 
memory on your computer than a text field. 

Number Stores only numbers. Useful for fields that may require calculations. For 
numbers that don’t require calculations (such as phone numbers) you are better 
off sticking with Text fields which use less space. 

Date/Time For date and time information. 
Currency Used for dollar amounts. 
AutoNumber Automatically generates a unique number for each new record. Useful for 

primary key fields. 
Yes/No Fields that contain only one of two values (such as yes/no, true/false, on/off). 
OLE Object For fields that need to contain an external object, such as a picture or document. 
Hyperlink For links such as email and web page addresses. 
Lookup Wizard… Allows the user of the table to choose a value from another related table. 
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Exercise 4. Creating Fields 
1) Make sure the first row in the Field Name column is selected. 
2) Type Last Name and press [Tab] or [Enter]. This will move you to the Data Type column. 
3) Leave the Data Type as Text and press [Tab] or [Enter] to move to the Description column. 
4) In the Description column type Last name of the student and press [Tab] or [Enter] to move 

on to the next line. 
5) For the next field enter First Name as Field Name, Text as Data Type and First name of the 

student as the Description. 
6) For the next field enter Date of Birth as Field Name. 
7) In the Data Type column we want to change it to Date/Time. An easy way 

of selecting Data Types is to press the first letter of the one you want. 
Press the letter D and Date/Time will become selected. Enter Birth date of 
the student for the Description and move to the next line. 

8) Complete the remainder of the fields so that they are the same as the ones 
shown below. 

 

 
 
Note it is not essential to provide a description for each field but it is a good idea. These descriptions can 

be used to provide information for people using the database. 
 

© Steve O’Neil 2005 Page 8 Of 20  http://www.oneil.com.au/pc/ 



Using Microsoft Access  Getting Started 

Exercise 5. Creating a Primary Key 
At the moment the table has no primary key specified. None of the fields would contain information 
that would be unique to each student. For instance, the same last name could be shared by more than 
one student so last name could not be used to identify a specific student record. The same is true for 
each other field. In cases like this where there is no field unique to each record, a new field can be 
created and used as a primary key. 

1) Click on the first record (Last Name). 
2) From the Insert menu choose Rows to insert a new row. 

 
You can also insert a new row by right-clicking on a row and choosing Insert Rows or by clicking the 

 icon on the toolbar. 
 

3) Enter Student No as the new Field Name. 
4) Choose AutoNumber as the Data Type. 
5) For the new field Description enter - Unique identification number. 

 
An AutoNumber field is the only one where you don’t need to type anything in to a record. For each 
new record entered, Access will automatically place a new number in the AutoNumber field. It is 
useful as a primary key field as it ensures that each record will have a unique number. 
 

6) Make sure the Student No field is still selected 
7) From the Edit menu select Primary Key. A key symbol will appear next to that field. 

 
You can also set a field as a primary key by right-clicking and selecting Primary Key or by clicking 
the  icon on the toolbar. If you accidentally set the wrong field as a primary key, then simply select 
the intended field and choose the primary key option once again to set it as the new primary key. 
 

Exercise 6. Saving a Table 
It is usually best to specify a primary key for a table before saving it as we have done. Otherwise, 
Access will want to create an extra field as a primary key. When a table is saved, it doesn’t become a 
new file. It becomes an object within the database file you have already created. In all other ways 
though, it is similar to saving a file. 
 

1) From the File menu choose Save (you can also press [Ctrl][S] or click the  icon). 

 
2) For the table name type STUDENTS. 
3) Click OK to finish saving the table. 
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Note You can call the table whatever you want but it is best to choose names that describe what sort of 
information the table will store. This helps when there are several tables in the database. Also, some 
developers like to name tables in uppercase letters and queries in lowercase letters or use prefixes in 
names to make it easy to distinguish between the two. 
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Exercise 7. Entering a Record 
While a table is open, you can quickly switch between the design view (used for modifying the design 
of the table) and the datasheet view (used for working with the actual data in the table). 

1) Click the View icon on the toolbar  (first icon on the far left). This is a quick way to 
switch between views. You can also change views from the View menu. 

 
 

2) Notice that the first column is for the Student Number field and it is filled with the text 
(AutoNumber). We don’t need to enter anything in this field since a student number will 
be generated automatically (remember that’s what an AutoNumber field’s for) so press 
[Tab] to move to the Last Name field. 

3) Type Robbins as the Last Name. Notice that as soon as you enter information, a number 
will appear in the Student Number column. Every record will be given a unique number. If 
you delete a record, that number won’t be used again. 

4) Press [Enter] after typing the name and the cursor will move to the next field. 
5) Complete the rest of the fields as shown below. 

 

Student 
Number 

Last 
Name 

First 
Name 

Date 
of 

Birth 
Address Suburb Postcode State Phone Gender Mark Comment

1 Robbins Mark 17-
06-
89 

4 
Kensington 
Ave 

Dianella 6059 WA (08)93751234 Male 78  

 
6) When you reach the last field (Comments) press [Enter] again to move to the next line. 

 
As soon as you move off that row, the record will be saved. Changes to table data are saved 
automatically in Access. The only time you need to save any changes yourself is when you’ve 
modified the structure of a database by adding or modifying the design of objects (such as tables). 
Changes to data are saved for you. 
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7) Click the View icon  to return to the Table Design view. 
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Exercise 8. Closing a Table and Closing a Database 
You can close a table the same way you would close an open document in another program. These 
methods include: 
• Selecting the File menu and then selecting Close. 
• Clicking the close button in the corner of the table as shown to the right.  
• Pressing [Ctrl][F4]. 
 

1) Use one of the above methods to close the table 
 
When you close the database window, you will be closing the database. 

 
2) Close the database window by clicking the close button as shown above. If there have 

been any changes to the design of the table you will be prompted to save the changes. 

Exercise 9. Opening a Database 
Opening a database in Access is similar to opening a file in another program. When 
access first starts, you can click the More... option from the task pane as shown to the 
right.  
At other times you can open a database by selecting File, Open, pressing [Ctrl][O] or by 
clicking the  icon on the toolbar. 

1) Use one of the above methods to bring up the Open dialog. 

 
2) Open the Student List.mdb database. 
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Table Properties 
A database will often be used by a lot of different people and the person 
designing it will not always be one of the users. For that reason, it is important 
to ensure that the database is designed to be easy to use. A table’s fields each 
have several properties that can be changed to make the table easier to use. 
The properties available for each field will vary depending on data type. The 
following table provides a summary of the purpose of each field property. 

Exercise 10. The Field Size Property 
Your database window should be listing the table in the database. Only one table has been created. 

1) Click once on the STUDENTS table and then click the  button above the list. This 
will return you to the table design view. We will modify the field size for some of the 
fields. 

2) Click on the Postcode field.  At the bottom of the window you will see a list 
of properties for the selected field. 

3) Since we will only use this field for Australian postcodes, we will limit the field size to 4 
characters. Click in the Field Size property and change the number from 50 to 4. 

4) In the top part of the window, click in the State field. 
5) This field will only be used to store 2 and 3 letter abbreviations for state names such as 

WA and NSW. Change the Field Size property to 3. 
6) In the top part of the window, click in the Mark field. 
7) For number fields, you have a range of Field Size options to choose from (such as byte, 

single and integer). To find out more about any property you want to modify, you can use 
the [F1] key to go straight to help about the selected property. Press [F1] now to find out 
more about the options for the Field Size property. 

 
8) Read through the information about the different field sizes that appears in the help 

window on the side of the screen. When you are finished, close the help window. 
9) For our marks field we want an option that allows for decimal places but doesn’t have a 

large number range. Single would be a suitable option so choose that for Field Size. 
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10) Click  or press [Ctrl][S] to save the changes to the design of the table. 
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Exercise 11. The Format Property 
The format property is used to control how information from a field will display. This allows you to 
ensure that all of the information in a table will have a consistent look. 

1) Select the Date of Birth field from the top section of the window. 
2) Click in the Format property at the bottom. An arrow to the right of the property indicates 

that there are some built-in formats that can be chosen from a list.  
3) Click the arrow to display the list and choose the Short Date option. This will mean that 

any dates in this field will be displayed as dd/mm/yyyy so that the 1st of January 2004 
would display as 01/01/2004. 

 
You can also create your own custom formats for any field. Remember that you can use the [F1] key 
for help on creating custom formats. 
 

4) In the Format property for the date, delete Short Date and change it to dd-mm-yy. This will 
mean that the date from the example in step 3 would appear as 01-01-04. 

 
5) Save the changes to the table design. 

Exercise 12. The Default Value Property 
This property is used to specify that a certain field will be filled in automatically. This is useful if 
most of the values in that field will be the same, since the user will only have to type information that 
is different from the specified default value. 

1) Select the Default Value property for the State field. We will assume that most of the 
addresses will be in WA so we will make that the default value. 

2) Enter WA for the default value. 
3) Save changes to the table design. 

 
Tip If you have a field where you want the default value to be the current date, you can use the =Date() 

function. Whenever you enter a record, Access will enter the current date in that field. 
 
When you save changes to a table design, you may see a message like the following. 
 

 
 
This simply means that Access wants to check data that has already been entered in to the table to 
make sure that it won’t conflict with any changes in the table design. 
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Exercise 13. The Input Mask Property 
Input masks are a way of ensuring that information is entered in to a database in a consistent way. 
They are often used with things like Dates and Phone numbers to assist with data entry. This can 
prevent problems with data being entered different ways by different users of the database. For 
example, different people using the database might enter the same phone number in different ways 
such as: 

• +61 08 0000 0000 
• 0000 0000 
• (08) 0000 0000 

In this instance, an input mask could be entered to ensure that everyone enters phone numbers the 
same way. 

1) Select the Phone field from the top section of the window and then click in the Input Mask 
property at the bottom. 

2) A button will appear to the right of the property . Click on this button to begin the Input 
Mask Wizard (you may be prompted to save changes to the table first).  

 
3) In the first step of the wizard, make sure the first phone number option is selected. 
4) Press [Tab] to move to the Try It: box. 
5) Type in your own phone number to see a sample of how the input mask will work. Notice 

that the brackets and spaces are put in for you so you only need to enter the numbers. 
6) Click Next to move to the next step of the wizard. 
7) The top part of this step will show the code for the input mask as !\(999) 9900\ 0000. We 

only want a 2 digit area code so change it to !\(99) 9900\ 0000. Leave the placeholder 
character as it is and click Next. 

8) For the final step, choose the first option, With the symbols in the mask, and click Finish. 
9) The Input Mask property will now contain !\(99) 9900\ 0000;0;_ (remember you can press 

[F1] for an explanation of what the input mask code means). 
10) Enter Input masks for the following fields as shown below. 

 
Date of Birth 99/90/00;;_
Postcode 0000;;_ 
State >aaa 
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11) Save the changes to the table design. 
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Exercise 14.  Creating Validation Rules 
A Validation Rule is a property which places a restriction on what can be entered in to a particular 
field. This can be used to make sure that only certain types of information are entered in to a field. If 
the user of a database tries to enter information which is not allowed by the validation rule, an error 
message will appear. The Validation Text property allows you to specify what the error message will 
say. 
First we will create a validation rule which limits the State field to Australian states. 

1) Select the State field in the top section of the window and then select the Validation Rule 
property in the bottom section. 

2) For the Validation Rule enter ACT or NSW or NT or QLD or SA or TAS or VIC or WA. 
When you press the [Enter] key after typing the rule, Access will place “ ”s around each 
entry. This rule will mean that the user of the database can only enter information that 
matches one of the entries in the rule. Now we will enter Validation Text in the next 
property.  

3) For the Validation Text property enter, Must be an Australian state. This means that if 
someone enters something that is not allowed by the rule, this text will appear as an error 
message. 

4) Enter the following Validation Rule and Validation Text for the Date of Birth field. 
 

Validation Rule <Date() 
Validation Text Must be earlier than today’s date 

 
This rule will only accept dates that are earlier than Date() (which means the current date in Access). 
Obviously we won’t have any students that haven’t been born yet, so any future dates entered would 
be an error. Validation rules and text can let a user know when they have made an error such as that. 
 

5) Save the changes to the table design. 
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Note If you create a validation rule, make sure you also provide a clear validation text message. If a user 
gets an error message, they’ll want to know why there’s an error. 
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Exercise 15. Other Field Properties 
Some of the other field properties may also be useful in table design. 

1) Select the Last Name field. We want to set the filed properties so that the user has to 
make an entry in this field. 

2) Change the Required property to Yes (wherever you have a drop-down list for a property 
 you can double click on the  to quickly change it to the next available option which 

would be Yes in this case). 
When the Required property is set to Yes, the user must enter something in this field or they will get 
an error. 
 

3) Change the Allow Zero Length property to No. 
When the Allow Zero Length property is set to No, entering a blank space and nothing else in the field 
will not be accepted as a valid entry. 
 

4) Change the Indexed property to Yes (Duplicates OK). 
 
When a field is indexed, it means that Access will keep track of what has been entered in to that 
field. That means that Access will be able to find information in that field a lot quicker which speeds 
up operations such as sorting, searching and querying. It is similar to the way an index in a book 
allows you to find information quicker without you have to search one page at a time. It is a good 
idea to index any field that is likely to be used a lot in searches and sorting. 
The Duplicates OK part simply means that it will be OK to have more than one record with the same 
last name in the field. 
 

5) Change the Indexed property to Yes (Duplicates OK) for the following fields. 
 

• First Name 
• Date of Birth 
• Suburb 
• State 
• Gender 
• Mark 

 
Note You can't index Memo, Hyperlink, or OLE Object data type fields. 
 

6) Save the changes to the table design. 
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7) Close the table to return to the Database window. 
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Exercise 16. Record Entry with Properties 
Now that we have modified field properties for the table, we will enter another record to see the 
effects of the changes. 
 

1) In the Database Window, double-click the STUDENTS 
table (this is a quick way to open a table in Datasheet 
View). 

2) The student record you entered before will be displayed. Click in the Last Name field 
underneath Robbins. 

3) Type Stevens for the Last Name and press [Enter]. 
4) Type Sarah for the First Name and press [Enter]. 

 
As soon as you begin entering a date in the Date of Birth field, the Input Mask will appear.  
 

5) We will test the Validation Rule by entering a date that’s not accepted. Enter a future date 
such as 020809 (remember you won’t need to enter the / since the input mask puts them 
in there for you). As soon as you press [Enter], the Validation Rule will recognise that the 
entry is invalid and the Validation Text will appear. 

 

 
 

6) Click OK to clear the message. You won’t be able to proceed until you enter a valid date 
or press [Esc] to cancel the entry. Enter 100489 (10/04/89) for the date and press [Enter] to 
proceed to the next field. 

7) Enter 24 Browne Ave for the Address Field and Yokine for the Suburb field. 
8) Enter 6060 for the Postcode field (notice the input mask in this field). 
9) Notice that the Default Value for the State field (WA) has already been entered. To test the 

Validation Rule, enter NY as the State. The Validation Text will tell you that only Australian 
states can be entered. 

10) Type WA for the State and press [Enter] (The Input Mask used for this field automatically 
converts entered text to uppercase). 

11) For the final four fields, enter the information shown below. 
 

Phone Gender Mark Comment 
(08)92498127 Female 62 New Student

 
12) Close the table when complete. 

 
The new data will be saved automatically in the Database. 
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Exercise 17. Data Entry Using a Form 
Many people find it easier to enter data with the help of a form. 

1) From the Database Window, make sure the STUDENTS table is selected. 
2) From the Insert menu, select AutoForm or click the  icon on the toolbar. 

 
A form will be created automatically using the Fields and Records from your table. 
 

 
 
You can move from one record or Field to another using your mouse or the keyboard. 
To use your keyboard: 
• Press ↓ or [Tab] to move to the next field and ↑ and [Shift][Tab]  to move to the previous field. 
• Press [Page Down] to move to the next record and [Page Up] to move to the previous record. 
• Press [Ctrl][End] to move to the last record and [Ctrl][Home] to move to the first record. 
• If you are already on the last record, moving to the next one will give you a blank record. 
 
To use your mouse, click the icons at the bottom of the form. 

 
  Next and previous record 
  First record and Last record 
 New record 

 Enter a number to be taken to that record number 
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3) Use any of the above methods to move to a new, blank record. 
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4) Complete the form so it looks like the one below. 
 

 
 

5) Use the form to add the records 4 to 6 as shown below. 
 

Student 
Number 

Last 
Name 

First 
Name 

Date of 
Birth Address Suburb Postcode State Phone Gender Mark Comment 

1 Robbins Mark 17-06-89 4 Kensington 
Ave 

Dianella 6059 WA  (08)93751234 Male 78  

2 Stevens Sarah 10-04-89 24 Browne 
Ave 

Yokine 6060 WA  (08) 9249 
8127 

Female 62 New student

3 Andrews Claire 01-11-89 322 Walter 
Rd 

Morley 6059 WA  (08) 9275 
1937 

Female 58  

4 McKay Tim 02-08-89 54 Coode St Dianella 6059 WA  (08) 9375 
5610 

Male 34 Need to try 
harder 

5 Petersen Robert 28-03-89 230 Flinders 
St 

Yokine 6060 WA  (08) 9249 
7128 

Male 83  

6 Sanders Jemma 30-05-89 183 Grand 
Prom. 

Bedford 6062 WA  (08) 9273 
9182 

Female 91  

 
6) After you have entered the last record, close the form. You will be prompted to save. 

 

 
 

7) Since this was only a temporary table to use for data entry, click No. 
8) Open the table and you will see the new records listed. 
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Exercise 18. Using Data Entry 
When you open a table, all of the existing records in that table will usually be displayed. The Data 
Entry feature will temporarily hide existing records so that you can enter new records in a blank table. 
This can be useful for the following reasons. 
 

• In a table with a lot of records, you may not want to have to go all the way to the bottom to 
add a new record. 

• If you have several records to enter, it is a lot easier to check what you have just typed when 
the new records are the only ones displayed. 

 
1) Make sure your STUDENTS table is still open in Datasheet View. 
2) From the Records menu select Data Entry. The 6 records you have already entered will be 

hidden. 
3) Enter the following records (notice that the first one you enter will still use the student 

number following the last one you entered). 
 

Student 
Number 

Last 
Name 

First 
Name 

Date of 
Birth Address Suburb Postcode State Phone Gender Mark Comment

7 Hutch Ian 28-09-89 18 Croft Ave Dianella 6059 WA  (08) 9275 7219 Male 67  
8 Springer Louise 18-10-89 56 Surry St Dianella 6059 WA  (08) 9375 9182 Female 72  
9 Davies Laura 09-07-88 14 Halvorsen 

Rd 
Morley 6062 WA  (08) 9276 8291 Female 54  

10 Carey Ivan 27-12-89 287 Light St Dianella 6059 WA  (08) 9375 2839 Male 67  
11 Chang Paul 14-03-89 89 Wellington 

Rd 
Morley 6062 WA  (08) 9276 2983 Male 76  

12 Sheppard Larissa 12-08-89 14 Chelsea Crt Dianella 6059 WA  (08) 9375 8127 Female 83  

 
4) When you have completed entering the records, go to the Records menu and select 

Remove Filter/Sort. All 12 records will now appear. 
5) Close the table (There won’t be any need to save anything unless you changed the design 

of the table by doing something like adjusting column widths). 
 
Tip A quick way of entering information in a field that is the same as information from the previous record 

is to use the [Ctrl][‘] (Control apostrophe) shortcut. For example, in the above exercise, if you wanted 
to add a thirteenth record that had Dianella for the suburb, you could use the shortcut since the 
precious record also had Dianella for the suburb. When you were in the Suburb field, you could press 
[Ctrl[‘] to enter the information from the previous record in the same field. 
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